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Minor Ailment and Contraception Service (MACS) 

Introduction 

The pharmacist’s scope of practice in many provinces includes the ability to assess and then prescribe 

appropriate therapy for patients who present with one or more of the Minor Ailment conditions listed as being 

approved. This document outlines the steps to follow when managing a patient encounter for a Minor Ailment or 

Contraception Service assessment in British Columbia using the Kroll Minor Ailments module. 

Store Configuration options that affect the Minor Ailment module 

For the pharmacy team member who has the proper permissions. 

From the Start screen: 

Click File > Configuration > Store > Rx > 7-Counselling 
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2 configuration options impact the Minor Ailment module: 

• Require electronic signature for finalize 

Other (Med Reviews, Minor Ailments, etc) 

If your system supports Electronic signature capture, click on this option. 

• Minor Ailments 

In last X months 

X represents how far Kroll will go back in the patient profile to select medications to be sent to 

RxConsultAction. NOTE: The default is 3 months. 

Minimum Data Requirements 

The following is a list of data elements that are required as part of using the Minor Ailments Module. Prior to 

launching the Minor Ailments tool, ensure that the following is entered: 

• Patient: First Name, Last Name, Address, City, Province, Postal Code, Birthdate and Gender (M/F) 

• Store Information (File > Configuration > Store): Store Name, Address, City, Province, Postal Code and 

Phone Number 

• Pharmacist (Edit > Users and Groups): First Name, Last Name, Type = Pharmacist and License 1 

• If not yet created, a Doctor card will be required for the Pharmacist, where the Designation = Pharmacist 

• Patient Family Doctor and Rx Doctors: First Name, Last Name, Designation and License 

If any of the above information is not included, the RxConsultAction component of the module will display an 

error. 

Initiating the Minor Ailment session 

The Minor Ailment tool can be initiated from one of two places: 

1. From an appointment record with Type = Minor Ailment Consultation. 

Click Launch Service when ready to start. 
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2. From the Professional Services area of the patient card. 

Click Ins and select Minor Ailment. 
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Using the Tool: Minor Ailments 

Once you have initiated the module, you will first be presented with the PharmaNet Profile request screen. 

 

Key enter your initials as noted and click Login. 

The “Minor Ailment - Select Data for Review” screen will display. This screen notes medications in the patient’s 

profile (based on the Store Configuration option) along with any drug allergies and medical conditions. 

Click on each tab to review the information. This information will be sent to the RxConsultAction tool. 



Minor Ailment and Contraception Service (MACS) - Kroll User Guide - British Columbia – June 2023  6 

 

Click OK. 

The RxConsultAction screen displays. 

 

The House icon 

indicates a prescription 

that is on the patient’s 

local Kroll profile.  The 

Cloud icon indicates a 

prescription that is on 

the patient’s PharmaNet 

profile. 
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Click on the Minor Ailments tab. 

The list of available Minor Ailments will display. 

Click on the Minor Ailment that the patient is seeing you for. 

 

The Minor Ailment form displays. 

 

Check that you have received consent from the patient. 

This 

information is 

sent over and 

displayed for 

you. 
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Check that you have reviewed the patient’s PharmaNet profile and confirmed their eligibility for the service. 

The rest of the form is now accessible. 

Scroll down and complete each section where appropriate. 

 

 

Scroll down to the next section. 

NOTE: The screenshots noted below are specific to the Acne Minor Ailment. The forms used for other 

minor ailments may differ. 

Check the symptoms that the 

patient is experiencing. If Other is 

selected, document the details in 

the freeform field that displays. 

If there was a previous 

diagnosis for the 

condition, check the 

box and document the 

details in the freeform 

field that displays. 

Click Add a 

Note if you 

want to add 

more.  

Document the 

details in the 

freeform field 

that displays. 
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Scroll to the next section 

 

If a prescription is warranted, click Add in the Prescribe section. 

If the patient presents with any 

exclusion conditions, click on it and a 

freeform field will display. If you feel 

it is still in the patient’s best interest 

to proceed, document your rationale 

in the freeform field. Proceed to the 

next step. 

NOTE: The system will not prevent 

you from proceeding even if nothing 

is noted in the freeform field. 

If No is 

selected, the 

system will 

display a note 

suggesting 

include skin 

care education 

in treatment 

plan. 

If Yes is selected, you will 

be prompted to key enter 

the treatment used, 

whether it was effective, 

and whether the treatment 

was well tolerated. 
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The Medication Selection screen displays. This screen will display the items included within the therapeutic 

category approved for the Minor Ailment. 

Scroll down and click on the drug 

that you wish to prescribe. 

The list of brands will display. 
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Click on the brand that you wish to prescribe. 

The prescribe screen will appear with the necessary fields prepopulated. If you wish, you have the ability to add or 

modify the information. 

 

This legend explains the icons that are 

noted beside each brand. 

Covered = Covered by Pharmacare. 

Not Covered = Not a Pharmacare benefit. 

Limited Coverage = requires further 

documentation to establish Pharmacare 

coverage. 

NOTE: The Quantity and Duration fields 

are normally prepopulated. However 

due to the products available to 

prescribe for Acne, these two fields 

require you to enter the data. 
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For Acne products only, key enter values into the Quantity and Duration fields. Number of refills can be noted in 

the Refills field if you feel comfortable. (NOTE: Refills can be noted for any prescribed product, for any Minor 

Ailment if you wish). 

 

To document the supplemental information that you will discuss with the patient, click Add in the Advice section. 

 

Information added here 

will be included on the 

prescription. 
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The Advice screen displays. 

Using the drop down menu select the Type of advice to be provided and then document the details in the freeform 

Details field. 

To add more Advice topics, click Add. 

Repeat the entry. Continue to add Advice topics until you 

have noted everything that will be discussed with the 

patient. 

NOTE: Everything documented in this section will be 

included on the documents generated by the module. 

 

If a referral is warranted as well, click Add in the Refer section. 

The referral information screen will display. 

 

Click on the arrow on the Refer to field and select the Health Care Provider who is to receive the referral. 

Click on the box to include the consultation summary. 

Key enter the rationale behind the referral in the free from field. 
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Click Add if you wish to create a second referral to another Health Care Provider. 

Click Conclude Intervention to continue. 

The Document Management screen displays. 

 

Under the Professional section on the left, click + adjacent to the Recipient field. 

The Addition of a Recipient screen displays. 

 

Click the down arrow on the Quick selection of a prescriber field. 



Minor Ailment and Contraception Service (MACS) - Kroll User Guide - British Columbia – June 2023  15 

A list of the prescribers who previously prescribed the prescriptions for this patient, that were transmitted from the 

Minor Ailment-Select Data for Review screen (described on page 6) will appear. 

Select the prescriber that you wish to send the notification to. 

The screen will be auto-populated 

with the necessary information for the 

selected recipient. 

Click Save 

 

 

 

 

 

 

 

NOTE: If no physician’s appear in the Quick selection of a prescriber field, manually key enter the 

physician’s information and then click Save. If the patient does NOT have a primary care physician, 

bypass this step. 
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Under the Patient section on the right, the Referral (if a referral has been set up) will be checked automatically. If 

you want to generate a supplemental document to hand to the patient, click on the desired document(s). 

 

 

Review the information entered. If changes are needed, make them and continue. 

When complete, scroll down and click Finish and Save. 

NOTE: The Claim Service will be checked by default. If you know that the patient has exceeded their 

annual limit, you may choose to uncheck this option. This results in Kroll NOT creating a Fee for 

Service claim. 
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Information from RxConsultAction will then be sent to Kroll. 

The documentation will automatically print. NOTE: If you are using the integrated Kroll Fax module, the 

prescriber notification will automatically be sent to Kroll Fax and sent to the Prescriber.   

The Minor Ailment Screen will display. 

 

 

 

 

 

 

 

NOTE: Once Finish and save has been clicked NO changes can be made. If there is a need to make a 

change after this step, you will need to initiate another Minor Ailment session. 
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You are presented with a number of options: 

• Dispense Now – Kroll will automatically create the prescription record and display it for you to review. 

• Unfill – Kroll will automatically create the prescription record with the Unfill status noted. 

• Queue for Later – Kroll will automatically create the prescription record and place it in the ToDo queue. 

• Print for patient to take elsewhere – Kroll will NOT create a prescription record, however it will print the 

prescription that you would then sign and hand to the patient.  This is used when the patient has indicated 

that they wish to have the prescription filled somewhere else. 

View summary – When selected, the consultation summary is displayed. 

 

Click Finalize and Claim Fee. 

If Electronic Signature capture is enabled, you will be prompted for your signature. If it is not activated, you will 

physically sign the document generated and scan it back into Kroll using the Document Scan utility. The 

document will include a 2D barcode so Kroll will know where to save it. 
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The fee for service F12 screen will display with the correct Fee for Service Drug card preselected. 
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The system will automatically note the store’s Phone number in the SIG field as per PharmaNet requirements. 

 

Click F12-Fill Rx to continue and process the Fee for Service claim OR click Cancel which will place the record 

into the ToDo queue to be processed at a later time. 

Once the Fee for Service claim has been completed (or moved to the ToDo queue), the F12 screen with the 

prescription details will display. 

 

The image of the prescription will be automatically saved to the prescription record. To view, click the Images tab 

in the lower left section of the record and then click the blue View Image hyperlink. 

NOTE: A future update will auto-populate the SIG field with the Store Phone number along with the 

information that is noted in the Default SIG field of the Fee for Service Drug Card. 
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Click Close. 

Click Plan Information located on the right side of the F12 screen. The Rx Plan Information screen will display. 

Click F2 on the Intervention Code 1 field. 

Search for and then select the PS 

intervention code. 

Click OK. 
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When you are ready, click F12-Fill Rx to continue. 

The Patient Card 

Whenever a Minor Ailment session has been initiated, Kroll will automatically create a Minor Ailment line item in 

the Professional Services history section of the patient card. 

 

Available Column Headers: 

• Type – the type of Minor Ailment 

• Status – indicates the status of the encounter record 

• Fee Status – notes if the Fee for Service claim has been paid 

• Created – the date the record was created 

• Completed – the date the record was completed 

• Follow ups – will note follow up created (Phase 2) 

NOTE: The inclusion of the PS intervention on the prescription record is a requirement for PharmaNet.  

For the time being, its insertion must be done manually. A future program update will automate this 

process. 
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• Started by – initials of the person on the terminal when the record was started 

• Completed by – initials of the person on the terminal when the record was completed 

• Provided by – name of the pharmacist who conducted the consultation 

• Drug(s) – drug(s) prescribed during the consultation 

To view the details of the professional service record, highlight the desired line item and click or press F2. 

 

The information noted in the Brown coloured header is similar to the column headers in the Professional Service 

history.  It also includes details of the Fee for Service claim: specifically, the status, who processed the claim, the 

date it was processed, the Rx number of the claim, the Fee and the intervention code included. 

The documents generated can be viewed by clicking on the tabs. 

• Tab with the Date and time – displays the complete consultation summary document including the 

prescription. 

• Referral Form - Physician tab (NOTE: If the referral is intended for another healthcare provider, that 

healthcare provider will be noted). The referral form displays. 
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• Service Summary (prescriber’s name) tab– displays what is to be or was sent to the Prescriber. 
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You are able to print any of these forms. Display the 

form that you wish to print by clicking on the 

appropriate tab and then click on the Printer icon 

located in the upper left corner. 

 

 

 

 

 

 

 

 

Using the Tool: Contraception Service 

Initiate the module in exactly the same fashion as noted above for a Minor Ailment encounter. 

When the RxConsultAction screen displays, click Other Services and then click Contraception. 
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The Contraception screen displays. 

 



Minor Ailment and Contraception Service (MACS) - Kroll User Guide - British Columbia – June 2023  27 

As with Minor Ailments, click Free and informed patient consent has been obtained (verbal or written) and 

click PharmaNet and patient eligibility have been checked. 

 

The rest of the form is now accessible. Scroll down and complete each section where appropriate. Form 

completion is similar to that for Minor Ailments however the content is specific to Contraception. The form is 

broken down in a similar fashion as that for Minor Ailments. 

Categories include: 

• Assessment 

• Context Assessment 

• Exclusion Conditions 

• Decision Support 

• Prescribe 

• Advice 

• Refer 

The Assessment section behaves in exactly the same manner as 

the Assessment section for Minor Ailments: the user is presented 

with options depending upon the answer recorded, freeform fields 

will display allowing for the documentation of more information 

and you are presented with the ability to Add a note in numerous 

areas of the Assessment section. 
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When the Assessment section has 

been completed and a prescription is 

warranted, click Add in the Prescribe 

section. 

The Medication selection screen 

displays. 

 

 

 

 

 

 

 

 

Click on the product that you want to 

prescribe. As with Minor Ailments, a 

list of available brands will display 

along with the icon indicating 

coverage status. 

Click the brand that you wish to 

prescribe. 
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All mandatory fields (those with *) are pre-populated. You may change any of these fields if you wish and even 

add a note in the Note on prescription freeform field. 

 

Any information noted 

here will be noted on the 

prescription. 
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Documentation of Advice and the Referral is done in the same manner as those for Minor Ailments. 

When completed, click Conclude Intervention. 

The Documentation Management screen displays. 

 

Once again, this is managed in the same manner as that for Minor Ailments. 

When completed, click Finish and Save. RxConsultAction will send information back to Kroll. 

The Minor Ailment screen in Kroll displays. 

Select the appropriate Prescribed Rx Action. 

Click Finalize and Claim Fee. 

 

 

 

 

 

If you want to print the 

supplemental Patient information 

sheet, check this option. 
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If Electronic Signature capture is activated, you will be prompted for your signature. 

 

Click Done. 

As with Minor Ailments, if Electronic Signature capture is NOT activated, the documentation will be printed. You 

will be required to sign, date and then scan the documentation back into Kroll. The 2D barcode will tell Kroll where 

to save the image. 

The Fee for Service record will display first. The correct Fee for Service Drug card will automatically be selected. 
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Once the Fee for Service record has been processed, the prescription record will automatically display.  
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As with Minor Ailments, before clicking F12-Fill Rx manually add the PS intervention code. As noted, this process 

will be automated in an upcoming system update. 

The signed and dated documentation will be easily viewed by clicking the Images tab and the clicking the blue 

link. 

To view the documentation generated, display the Professional Services section on the Patient card, highlight the 

record that you want displayed and click F2. 

Click on the tab to display the document. 
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To print any of the forms, click the Printer Icon on any 

of the tabs. 
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Quick Minor Ailments FAQs 

Do I need to have Electronic Medication Reviews enabled in my Store Configurations for Minor 

Ailments? 

No. Electronic Medication Reviews do not need to be enabled to use the Minor Ailments module.  

Why am I prompted to select prescriptions before launching the Minor Ailments tool? 

The prescription selection provides the Pharmacist the opportunity to easily view patient prescription information 

within the Minor Ailments/RxConsultAction tool. 

I have Advanced/Paperless workflow configured in Kroll. Does the Fee for Service claim go 

through my workflow? 

A Minor Ailments Fee for Service claim will move through your workflow the same way a Medication Review Fee 

for Service claim currently does. If you wish to have adjustments to how your Fee for Service claims are 

processed through Workflow, please reach out to our Kroll Customer Experience team. 

I don’t have a signature pad. How do I sign the prescription? 

If you do not have a physical signature pad, or the Kroll Virtual Signature module, the necessary documentation 

will print for the Pharmacist to sign physically, and can then be scanned into Kroll. 

Why didn’t the Rx image save automatically for the new prescribed medication? 

As signatures are required for authorized prescriptions, Kroll will only save the Rx image if an electronic signature 

is being captured as part of the Minor Ailments tool. If you have electronic signatures available in Kroll, go to File 

> Configuration > Store > Rx > Counseling and enable “Require electronic signature for: Other”. If you are 

interested in electronic signature capture options, please speak with our Sales team. 

How do I reprint documents? 

Return to the Professional Services section of the Patient card. Select the Minor Ailments entry and press F2. 

Each document generated will have a tab. Each tab has a printer icon, which will allow you to re-print the 

document. 

Is there a report for how many Minor Ailment encounters I’ve done? 

The Expanded Scope of Practice Report (Rx report) will provide you with a count of the Professional Services 

provided by Pharmacy User. The Rx for Drug/Doctor Groups Report will provide detail of the Fee for Service 

claims when the Pseudo DIN drug cards are added under the Drug section of the report set up screen. There are 

plans to provide a more comprehensive report in the near future. 


